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Introduction to Bluebeam Vu

This is a guide for how to use Bluebeam Vu for your PDF markup and collaboration needs. Vu
does more than just read PDFs, Vu allows you to join collaboration sessions using Bluebeam’s
cloud solution, Studio. Those of you who are familiar with the desktop application, Bluebeam®
Revu®, know that Studio combines the best of cloud storage and collaboration. From within Revu,
you can upload a PDF to the cloud, invite attendees to join Studio and add markups to the same
PDF in real-time or on your own time. With Vu, you can access files stored in the cloud and join
Studio sessions that are already in progress - all you need is the session ID number. Once you’ve
joined, a selection of markup tools will display allowing you to add text, highlights, callouts, clouds

and more to PDFs. Working in real-time with all of the participants in the review.

By participating in a Studio session, you are able to collaborate with members of your project team
on one or more files. Use the Markup and Measure tools to add comments to the PDF document
Change, edit, and delete markups and measures that you have created and Reply to any markup

or measure that other Attendees have created.

You will see markups and measures added by other Attendees immediately as they are added or
changed. You can send an alert about a markup to other Session Attendees to direct their
attention to it. You can follow an Attendee and your display will update to show what they are
seeing. You can chat with other Attendees and you can see a record of each markup, comment,

and chat as it happens.

You can Reply to other Attendees' markups and measures, but you cannot edit them. You can add
markups and measurements, but you cannot make changes that change the PDF's content.

Menus and toolbars that cannot be accessed during Studio Sessions are grayed out.

The Session Host may restrict an Attendee's ability to save, print, or add markups to documents in

the Session.

You can continue to work with other documents while you work in a Session. The document tabs at
the top of the Vu workspace will show a small Studio icon for documents that are part of a

Session.



Who can Initiate a Bluebeam Studio Session

There are two roles within a Bluebeam Studio Session. That of an initiator, and that of a
participant. If you are going to initiate a Studio Session you need to have any tier of Bluebeam
Revu installed on your pc. However, to be a participant all that is required is Bluebeam Vu (a

free PDF reader), though Bluebeam Revu can be used as well.

Initiator Install Bluebeam Revu

Participant Install free Bluebeam Vu
download (unless the partici-
pant already has Bluebeam
Revu)

What Do | Need to Attend a Studio Session

You need only three things (besides a computer) to participate in Studio:

1. An installation of Revu or Vu (version 8.5 or above), or Revu for iPad.

2. An email address (to create a Studio Server account).

3. An Internet connection.

Attendees do not need to purchase Revu to participate in Studio. Both Vu and a trial version of Revu

can be used to access Studio, both of which can be downloaded from http://www.bluebeam.com.

There is a link in the Studio email review invite to download the free software.
A Studio Account must be created so the Host can authorize you to participate in the Session and
so other users can identify you. The account is free and only requires a valid email address.

An Internet connection is required so you can connect to the Studio server. A dial-up connection is

not recommended.



Downloading Bluebeam Vu

Bluebeam Vu

The superior free PDF viewer designed for you

Go to the following location to download Blue-

Bluebeam Vu does more than just read PDFs. With integration into documeant management systems and

bea m Vu innovative File Access™ technology, Vu allows you to access, organize and navigate PDF files with ease. View
PDF files as they were meant to be viewed—all annotations display clearly and accurately so nothing is
http ://bluebeam. comlus’prOd ucts/free-viewer/ missed. Vu also allows you to fill out and save PDF forms, digitlly sign PDF documents, and connect to our

ud-based collaboration solution, Blueheam Studio, to access and view files stored in Studio Projects and

collaborete on the same PDFs in real-time Studio Sessions. You can even install Vu 2016 alongside Revu 2016

o

if all your organization’s shared Open Licanses are in use. Did we mention it's free?

[fyou are not a Revu® user and need a frae PDF viewer, download Vu now.

® DOWNLOAD

(% Bluebeam Vu 2016.5.1 - InstaliShield Wizard X

Bluebeam Vu 2016.5.1

Select the language for this installation from the choices below.

Click on Next

Please read the following license agreement carefully.
Bluebeam(R) Vu(R) Version 2016.5

(c) 2002-2016 Bluebeam, Inc. All Rights Reserved.

|Protected by U.S. Patents 7,600,193; 7,600,198; 7,907,794; 7,971,149;

8.244.035: 8,443,280; 8,509,535; 8,737,746; 8,990,681,

Protected by European Patent 1958056.

Prctec’ted by Australian Patents 2006316845; 2006316858; 2008209631; 2008209632.
| Other Patents Pending in the U.S. and/or other countries.

Ccpyrlght law and |nternatlunal treaties protect this computer software program.
or distribution of this software program, or any portion of it,
W|II be prusecuted to the maximum extent possible under law and may result in civil and criminal penalties.

Select “l accept the terms in the license agree-

LH]
me nt Portions Copyright 2007-2011, Stephan Tolksdorf. All rights reserved.
FParsec incorporates data derived from the Unicode Character Database v. 6.1.0,
Copyright 1991-2012 Unicode, Inc., which is dlstrlbuted under the following terms:

. htp://www.unicode. _of_use
C I Ic k o n N ext. |Portions Copyright 2006 Damien Miller <djm@m|ndret.erg> (jBCrypt)

|Portions Cobvriaht 2010-2012 SharoDX - Alexandre Mutel

O | accept the terms in the license agreement

@ | do not accept the terms in the license agreement

Cancel




Downloading Bluebeam Vu
Continued:

(% Bluebeam Vu 2016.5.1 - InstallShield Wizard X

If you have Adobe already installed on your select your installation options:

Computer do not check “Make Bluebeam (LIt TIEE R
Place a shortcut for Bluebeam Vu on the desktop.

Vu your defaUIt PDF Vlewer‘” M Install Internet Explorer plugin for viewing PDFs.

Ml Preload Bluebeam Vu at Startup (Quick Launch).

Select your Destination Folder.

Click on Install.

Destination Folder

C:\Program Files\Bluebeam Software\Bluebeam Vu\2016

(% Bluebeam Vu 2016.5.1 - InstallShield Wizard X

Installation Complete

Bluebeam Vu 2016.5.1

Vu has been successfully installed. Click Finish to exit the wizard.

Click on Finish.

[
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Creating a Studio Account

I ‘Welcome >
Bluebeam Studio™ is the ultimate solution for real-time
collaboration and project management. Integrated within

N Bluebeam Revu, Studio allows you to manage projects digitally

from start to finish anywhere, at any time, from a desktop,
tablet PC or iPad

; There are two sides to Studio - Projects and Sessions. With
Bluebean Vi you can aceess and navigale PDFs and any
other filo type stored in the cloud using Studio Projocts

t Collaborate on the fly by joining oxisting Studio Sossions,

. whesre you and your project pailners can comment on 1he

CIle on Create N ow U I o same PDF togethor in real time or soparatoly on your own time.
. Revieew desigrs and product specs, modify repornls and chal

with collcaguos instantly.

There arc no limits to what you can do when loveraging the

combined power of Revis and Sloadio
|
|
Login Create New
Welcome to Bluebeam Studio =

Studio is a place to connect, create, and collaborate with anyone,
arywhere, and at any time. Invite who you like or just go solo. Add
comments today, tornorrow, together or separately all frorm within
Bluebearn Revu. So, enter the Bluebeam Studio and make a little
magic.

sfu I o Learn more

Terms of Use

CIle on Ag ree BLUEBEAM STUDIO TERMS OF USE AGREEMENT x

This Bluebeam® Studio Terms of Use Agreement (“Terms of Use”) is an agreement between you (either
an individual person or a single legal entity, who will be referred to in these Terms of Use as (“You”), and
Bluebeam, Inc, referred to as (“Bluebeam”).

1. Acceptance and Modification of Terms of Use

1.1 Acceptance. Your use of the Bluebeam Studio Services as described below is subject to these
Terms of Use, which operate in conjunction with the Bluebeam End User License Agreement (“EULA”) for
Bluebeam Revu® and the Bluebeam Online Privacy Policy, incorporated herein by reference. You can find
the most recent EULA and Privacy Policy respectively at htp: 1 1.com/Revu/EULA and

~

LT T — T T T — T —— -

} Create Studio Account X

If you have an existing Studio Account — Click

. . . Server: |studio_bluebeam_com |
on “Login with Exiting Account” - see next page.

E-mail: | |

Password: | |

Enter your E-mail address. ' Confirm: | |
[ ] Remember password

Enter your password (See Message about pass-
words from Bluebeam below)

Name: | |

Enter your Name as it will show up in the Review
comments. Login with Existing Account | Cancel

Click on OK.

S ONUEAET ASLEIEIE Y DL ML £ AT 1

Bluebeam Vu x64: Error

Invalid Password. Studio passwords must be between 8 and 32
characters long and include a lowercase letter, an uppercase
letter, one number and one special character (such as @, #, $,
& 1, +).

|
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Creating a Studio Account Continued:

If you have an existing Studio Account fill in Hdi X
the fO”OWIng information. Studio Server: Estudio_bluebeam_com W |
You can check “Remember Password” if you “ |
L : Fmail
do not want to enter this information every =
. . p vord
time you enter a review. o |
[ ] Remember Password Lost Password
Do not check “Use Windows Authentication | | [ usewiidows Auttenbeation
I
Click on OK.
Create Account Cancel

You will see the following screen:

Welcome to Vu

Bluebeam Vu® does more than just read PDFs. With integration into document management systems and innovative File Access™
technology for organizing PDF files, Vu allows you to access and navigate PDF files with ease. View your PDF files as they were
meant to be viewed—all annotations display clearly and accurately so nothing is missed. Vu also allows you to fill out and save
PDF forms, digitally sign your PDF documents, and connect to our cloud-based collaboration solution, Bluebeam Studio™, to
access and markup files stored in Projects and Sessions. You can even install Vu 2016 alongside Revu 2016 if all your organization’s

shared Open Licenses are in use. How's that for a good Vu?

View PDFs with Ease.

The Vu interface is . At the left, right and bottom are panels

that can be opened and closed to expose the File Access tab, Markups list

and Bluebeam Studio. Each PDF file that you open in Vu gets its own tab so
you can quickly toggle back and forth between documents. Vu's MultiView"
technology even allows you to split your screen up to 16 times, sync tabs to

pan and zoom in unison, or drag a file to another monitor to optimize your

viewing space.

ma e g w R
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Default PDF Associations

In a mixed environment (using both Adobe Acrobat/Reader & Bluebeam Revu/Vu), a choice has to
be made as to which PDF reader is set as the default PDF reader. In most cases this is generally
just a user preference, but in a mixed environment leaving Adobe Acrobat/Reader as the default
PDF reader is recommended. This is recommended because Acrobat Shared Review invitations
use the default PDF reader to open links to the Shared Review, while Bluebeam Studio Session
invitations know to use Bluebeam Revu/Vu regardless of whether or not it is the default PDF
reader. In this scenario a user could navigate both invitations without running into any problems.

In the case that you are NOT in a mixed environment, shown below are instructions for setting
Bluebeam Revu/Vu as your default PDF reader in Windows.

Setting the default PDF reader in Windows

From within Bluebeam Revu/Vu, click the drop-down menu next
to the Bluebeam Revu/Vu symbol in the upper right corner of the
screen, then click on Administrator.

Show Grid Shift+F9
Snap to Grid Ctrl+Shift+F9
Snap to Content

Snap to Markup

Reuse Markup Tools
Synchronize Views

Show Full-5creen Crosshair

Administrator

Document Properties  Cirl+D

Preferences Crl+E

On the Bluebeam Administrator || 5,5 [ et conig | Prnter | Logging | Rew |
dialog, select the Revu/Vu tab. In |

. Bluebeam Revu x64 PDF lcon Color
the Bluebeam Revu/Vu section [%] Use as Default PDF Viewer | @ Blue
check the Use as Default PDF D 64-bit © 32-bit © Red

[¥] Cuick Launch

Reset Settings
Backup Seftings
Restore Settings

Web Browser

Viewer checkbox, then click OK.

[T] Display PDF in browser

apply | [ ok | [ cancel |
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Joining a Review Session

To join a review session, click on the link provided in the Session invite.

You're Invited Click on the Session ID to
open the Review Session

Session [0:
Server: si

P 0115(47)102, Minnehaha County, PCN 025C
SD115 SD115 - Fm 248th St, south of Dell Rapids, to Quarry Road/Zero St in Dell Rapids Structure # 50-208-022
Grading & PCC Surfacing, Replace Str

Plan Review Due 11/10/16 5:00 PM

New to Studio?
install one of the following applications to your c

y markup PDFs v

Bluebeam will launch. If this is your first time into a review session, create a Studio account.
DOT Staff:

Enter your State email address and a password. Enter Create'smdiqmt_' n m
your name as you want it to show up in the review o
comments. Select “Remember password” and select Emal
“Allow other users to see my e-mail”. Click OK S

Confim;
Other Reviewers:

|| Remember password

Enter your email address and a password. Enter your
name as you want it to show up in the review comments. Nare: |
Select “Remember password” and select “Allow other "] Mlow other users to see my E-mai
users to see my e-mail”. Click OK -
If this is not your first time in a review session, you may || =eEse o Lok [ omos |

have to enter your studio log in information if you forgot
to check “Remember Password”

14



Review Session Layout

Please refer to Customizing the Command Bar on Page 27 in order to see the Markup Group
and Measure Group in the Command Bar in order to make comments on the review plans.

When you enter a Bluebeam review session you will see the Studio Session Tab located on the
right hand side of the screen. This tab displays the attendees of the session, a list of the documents
in the session, and a record of all actions that take place on a review document. On the bottom of
the screen you will see the list of all comments placed on a document. If this bottom tab is not

Review Session Tab

Tool Chest - Save your
STATE OF SOUTH DAKO

A own comment tools that parnient of Tseortinon | Status in the Review
! ol USE in reviews PLANS FOR PROPOSED Session

Y OJECT P 0115(47)10
S.D. HIGHWAY 115 rerry=——s
MINNEHAHA COUNTY -

Grading, Curb and Gutter, Storm Sewer, Struck,
racing, Cur ang Gute, Sorn Seer, Stucre Attendees

PCN 025C

\.‘ L, 1
5 1 IDELD ] Lz,
RAPIDS, T

List of Comments 1= 1| Documents in the

Review Session

Split Screen Buttons - Click here to open and ]
Allowing Viewing of close Comment List TARLLE
Multiple Pages at the

Same Time F £ ' Record, Notification
= . and Message
reer s Center

Record | Nolifications  Pending

EECE Y o W-EW N N N

Grid Snap Nuse Sync ~ 00 x (111,11.03)

open, click on the blue half circle with the white dot in the middle. On the left of the screen you can
have the Tool Chest open with your own comment tools or other options.

All comments that are made get saved instantly to the Bluebeam review session; you do not need to
manually save any comments. You can only delete comments you have made. If someone else
has made a comment that you would like respond to just right click on their comment on the plans
or in the Markup List and select reply.

You can leave and rejoin sessions as many times as you want as long as the review session has
not been closed. The review session will be closed by the Project Manager (Host) in accordance
with the procedures shown in this manual.

15



Reviewing Plans & | ®

Reviewers may print digital review documents to SRS R -1 Rt RS
paper and mark them up; however, they must T Home | B Session |4
transfer these comments onto the digital review
documents. Any written comments that are

ﬁ‘_ Leave !; Finish ™ Settings

. Minn025C 08-15-16 5 PM - 475-457-460

received can be scanned to a PDF and attached [ . .
to the session documents using the attach file

* Altendees =

command. Please be careful when you place a
comment or markup so that you do not cover up areas of notes or details that may need to be
review by other individuals.

1. All reviewers must set your review status to “Reviewing” by clicking on the drop down arrow
shown to the right. Note: If you leave the session and return your status will stay as Reviewing.

2. Next select a document to review from the studio session tab. Note: There may be more than
one document is a session review. Example: DOT Plans and Utility Plans.

3. Proceed to make comments using the various markup tools. Make comments on other reviewer
comments by right clicking on the comment and selecting reply.

4. After your review of the documents is completed set your status to “Finished”. This status lets
the Project Manager (Host) know which Reviewers have completed their reviews. Note: You
can still enter the session if your status is set to Finished.

5. If a review comment is rejected, the reviewer will receive an Alert email from the Consultant/
Designer that rejected your comment. See pages 17-18 of this manual.
Commenting Best Practices

A text note can be added to any of the other comment tools by double clicking on the markup after
you place it. The text note box must be closed after the comment is made by clicking on the X in

the top right corner of the note. The example below shows a note being attached to the rectangle
tool.

T / | 3. Close the text

3 . .
SALVAGE AND STOCKPILE ASPHALT MIX AND GRANULAR BASE box by cl ICklng on
MATERIAL r station
wes. Ths| the X.

An astimated 15,6784 lons (8295 Cubic Yards) of asphall mix and Shouddens.
granuly base maleria chall be sahaged from the entine fength of the = and the
exizling highway and stockpdad &t 8 site furmished by the Contractor and
safisfaciony 1o the Engineer

The quartity of salvape asphait mix ad granuiar basae matenal may wany hL
F from the pians. Mo adstment will be made b tha conlrac! unil price for
varialions of the quantily of “Salvage and Stockpile Asphalt M and pic wards of
E Granular Baza Metensl 5 e and boo:
ot 10 feet o
Salvagad Asphsit aither the
o 3 ik 7 athvagped
Location | Begin Statica | 1o | End Station Wi m;:"”"" ki
Materind yhon) ]
Shoulders 10+82 55 o 11042100 1d.115?.\ AR mol_dq MECAEEENY Iolams'raLe and backfill Ill're dleepl pipas ar'ad:l ow culverts 1
2 = 7 > inchading tabor, equipment, and incidertals shall be incidensl o the
Sioujders | 1190000 101 CreseTa0 12210 et awt Uil prias e bl et T “Unictmssiihed Exceavstion . Pyl o i
16,6784 disep pipe and bax cubvert excavation shall be based anly on plars quantity :
and massurement of {hese excavation quantities dunng construchon shall :
Sik
LE SURFACING Al A T . F
1. Place Rectangle 2. Double Click on the rec-  |ras fia inciiitea :
les were drlied fo check the depth of In place swacing The profile sheets, Thie &
i5 @ log of thasa bas] nosas. jand bo clvirts are
tangle to place note. parbin. Stk Lt
Aing 1B1e &5 fumishad Tor infaimason only. pr fora pips.
Driving Surface o
Centerling Depth PCCP Depth Granular “Fie ICeaL eldpation of Original
Sta Peetit Fest Rt (inches) Base (inches) Grognd, Undarcut Line, of
15=00 10.4 an B0 { Botiom of Remagved or Salveges 1
23400 10.0 a0 an igmcing 2
ZF=00 103 an 8.0 b
31«00 7e a0 B0 Excavation Linits___ £
35+00 100 a.n a0 fy L
PR ann an an AT :
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Responses To Review Comments and Revisions

When the review period ends review comments can no longer be published to the review Session.
The Project Manager will need to notify the Consultants/designers from each section that the re-
view has ended and responses to the comments and revisions are to be completed by a certain
date. All review comment responses shall be shown in the review Session. In order for the Consult-
ants/designers to respond to the comments on the review Session the review deadline will need to
be extended by the Project Manager (Host).

Statuses are useful for keeping track of comments and letting review participants know how you are
going to handle the comments. Each Consultant/designer that are responsible for responding to the
comment shall set the status of their part of the comment. The review status appears in the Markup
List along with the name of the designer setting the status. If more than one designer sets the re-
view status for the comment, both names and review statuses appear in the comment.

Select the comment in the comments list and right-click to show the options menu. Then choose an
option from the Set Status menu. If the designer has complied with the changes requested by the
comment the option would be “Completed”. The Status “Completed” can be both the Status and the
Reply when the comment is totally complied with. If the designer has not complied with the changes
requested by the comments the option would be “Rejected”. If the comment is rejected then the
Consultant/designer shall explain why it was rejected by Replying to the Comment. With a Filter of
the comments for the word “Rejected” the Project Managers and reviewers can see the comments
not complied with.

Copy 'trprl2924'

Reply

Set Status Accepted

Alert Attendee Feeied
Cancelled

Completed

Properties Mone

Any Consultant/Designer that rejects a comment shall Alert the person that made the review
comment and the Project Manager with their Reply to notify the reviewer. The Project Man-
ager shall confirm that all comments have been given a status and if the comment has been
rejected an Alert has been sent to the reviewer. All Alerts are recorded and will become a
part of the Session Report.

17



Rejecting Comments, Replying to the Rejected Comments and Alerting the
Reviewers to Rejected Comments

In the Markup List if you set the Status of a comment to “Rejected” the Consultant/Designer shall
first reply to the rejected comments by right clicking on the comments and giving the reasons for
the rejection. Then the Consultant/

Designer shall Alert the Reviewer and I  Copy Rejected set by Raccke on 07/25/2016 at 5:56:19 PM'

the SDDOT Project Manager by selecting
both the Rejected Status and the reply in
the Markup List and then right clicking on Layer

the selected comments. Lock Chrl+Shift+L

Collapse

Then click on Alert Attendee and select L Reply
the reviewers name and the SDDOT
Project Manager’s name.

Set Status
Check

Alert Attendee
An email will automatically be sent to the
reviewer and SDDOT Project Manager
with a picture of the review comment and
the response. Hyperlinks in the email will
take the reviewer to the exact

location of the comment and Markup Alert in
response in the plan review. R

Delete

Properties

Note: If Reviewers want to contest
the rejected comments they can
send the Consultant/Designer, that
rejected the comment, an email by
right mouse button clicking on the

Consultant/Designer name in the ject R Audbor: |ohn Smith
. . b pif Page: Page E3
attendee list (upper right corner of Layer:

the screen) then select E-mail. Cons nall for this sizmof o
The SDDOT Project Manager shall
be included in the email.

Aunibor: Bran F
Page: Fasa & - B3

Layer:

Status: Fajactad




Completed Review Session Report

Note: Before creating the Session Report the Project Manager shall verify that all Rejected
Comments have a corresponding Alert record or e-mail that the reviewer was notified of the
rejected comment.

After the plan review and responses are complete the SDDOT Project Manager shall generate a
Session Report that has a record of all activity and comments/responses.

A copy of the PDF Package Report shall be sent to the Consultants for their records using the DOT
FTP Site or using the “Projects Folder” in Bluebeam Revu.

19



Bluebeam Revu/Vu Studio Session Procedures for SDDOT Projects

Once proper electronic documents are submitted, the SDDOT project manager shall combine the
separate PDF’s into a single PDF and name the combined file as shown on pages 56-57 of the
Bluebeam Revu Manual. Note: The Project Manager may add the Utility Spec., Utility Plans,
Building Spec. and Building Plans as a separate document(s) in the Session Review.

1.

The SDDOT project manager shall start a Session as shown on pages 75-79 of the Bluebeam
Revu manual. Make sure that the Session Name in the Session Invitation has the CountyPCN#
Review Due Date Time Ex: Minn025C 08-15-16 5 PM. The project description shall also be
placed in the Message of the Session Invitation. If the project is a FHWA oversight project,
include the FHWA reviewers email addresses in the review attendee list when you set the
Session up. FHWA already has Bluebeam Vu installed on their computers. If Local
Governments or other entities would prefer to do a electronic review include their email
addresses in the attendee list. They will be able to download the free Bluebeam Vu software
from a link in the Bluebeam Revu Session invite email that they will receive. Make sure that all
Consultants/Designers are included in the Session along with the list of Reviewers.

The Reviewers shall follow the instructions on Pages 14-18 of this manual. If review comments
are going to be late and can not be add to the Session before it ends please notify the project

manager that invited you to the Session.

3. When the Session has ended the SDDOT project manager shall proceed with the review

response process for the Consultants/Designers so that they can make review responses/
revisions (See pages 17-18). Every comment shall have a “Reply” and a “Status”. Any
Consultant/Designer that rejects a comment shall Alert the person that made the review
comment with the Bluebeam Alert process (See pages 17-18). The SDDOT project manager
shall assure that all reviewers with rejected comments be notified with a justification/response
by reviewing the Session Report Record Summary that is created (Page 85) of the Bluebeam
Revu Manual when the plan review is archived. The SDDOT project manager shall send the
Consultants a copy of the PDF Package Report on the DOT FTP Site. After the Session
Report is created the SDDOT project manager shall Finish the Session by following the

instructions on page 86 of the Bluebeam Revu Manual.

20



Navigating in Vu

Vu provides numerous methods for navigating, panning, and zooming in and out of a
document.

& Navigating with the Mouse or Keyboard

The primary method for navigating is the mouse. Vu works with all types of mice, however it
is suggested that you use a 3 button mouse with a scroll wheel for the optimum performance.
The following diagram identifies how the mouse buttons are used.

Left Mouse button:

« Click to select iterns
+ Hold down to drag
selected item >

Scroll wheel:

* Dynamic zoom infout
» Click and hold wheel to Pan
* Double click to fit and center

Right Mouse button:

*Click to view menus

& Zooming with the Mouse

The scroll wheel is the most convenient method to navigate a PDF. Zoom in and out by
scrolling the mouse scroll wheel forward and backward.

Note: The scroll wheel will change behavior depending on the display of the page. By
default, the scroll wheel zooms when in Single Page Mode and scrolls in Continuous Mode.
You can change this behavior in the Navigation Preferences.

Double-click the scroll wheel to fit the entire PDF page to the current workspace window.

Double-click the left mouse button (or double-tap a tablet PC stylus) to display the tablet
zoom control.

A

To scroll using the tablet zoom control, click and hold in the blue-shaded area, then drag
the cursor up or down to zoom. Click outside the blue area to exit the control and pan the
document.

= Zooming with the Keyboard

Navigation Keyboard shortcuts:

Zoom out — CTRL+MINUS

Zoom in — CTRL+PLUS

Actual Size — CTRL+8

Fit Page — CTRL+9

Fit Width — CTRL+0

Select Zoom tool — Z

Toggle between Pan or Select tool and Zoom tool — SHIFT+Z
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Navigating in Vu Continued
= Panning with the Mouse
Click and hold the scroll wheel down to pan the document.

Click and drag the horizontal and vertical scroll bars as you would in any Windows
application.

= Panning with the Keyboard
Press the LEFT ARROW, RIGHT ARROW, UP ARROW and DOWN ARROW keys.
@ Navigating with the Navigation Bar

The Navigation bar along the bottom of the workspace typically holds the Pan and Zoom tools
in the center.

& To zoom in on a particular area of the document

1. Click the = Zoom tool or press 7.

2. Click and drag a rectangle over the desired area. Upon release, the defined area will
zoom to fill the workspace.

& To pan around the document

1. Click the ¥ Pan tool or press ESC.
2. Click and drag to move the view in the main workspace.

It is also possible to set the zoom level manually to a percentage, or to automatically fit the
width or the whole page.

1. Click the zoom list to the right of the s to choose a specific page size
percentage.

2. To zoom to a setting rather than a percentage, choose one of the options at the
bottom of the list (Actual Size, Fit Page, or Fit Width).
& To jump between pages and views

On the right side of the Navigation bar, there are buttons designed to provide efficient
movement between pages and views in the workspace.

3of8 |

Each of the buttons is explained below:
4 First Page (HOME): Click to jump to the first page of the PDF.
4 Previous Page (CTRL+LEFT ARROW): Click to go to the prior page of the document.

3off

. Indicates the current location in the PDF.

» Next Page (CTRL+RIGHT ARROW): Click to go to the next page of the current document.
Pl Last Page (END): Click to jump to the last page of the document.

Go To Page: Click to specify a page in the document to which to jump directly.

© Previous View (ALT+LEFT ARROW): Click to go back to the previous view in the main
workspace.

© Next View (ALT+RIGHT ARROW): Click to go to the next view in the main workspace.
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Page Layout

Vu allows for several different page layouts, including several configurations and views.
= Page Layout Configurations

PDF files can be displayed in several different configurations.

I Single H Continuous

To set the page layout, on the Command bar, click the *™ View menu and select the desired
mode.

L4 Single Page mode (CTRL+4): Fits individual pages to the current workspace window.

[Z] Continuous Page mode (CTRL+5): Displays all pages in a single column.

o Side-by-Side mode (CTRL+6): Displays two pages side-by-side with the even page on
the right and the odd page on the left. Page 1 will display alone.

Continuous Side-by-Side mode (CTRL+7): Displays all pages in the Side-by-Side
mode.

= Page View

The default zoom of pages are controlled with the page view commands. On the Command
bar, click the ™ View menu and select the desired page view.

) Actual Size (CTRL+P8): Displays the page at 100% or the true size of the page.
Fit Page (CTRL+9): Fits the entire page to the available display area.
™ Fit Width (CTRL+0): Fits the width of the page to the display area.
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Page Layout Continued

& The Dimmer

The Dimmer can be found on the Navigation bar. Use the Dimmer to toggle on and off the
underlying content stream in order to better see annotations. The effect can be seen in the
example.

Ramove _ — Remove

< BLODGKING AS
REQUIRED

To set the level of dimming, click the arrow on the Dimmer button. The lower the
percentage, the less intense the underlying PDF will appear and the more the annotations
will “pop.”
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MultiView and MultiView Extended

Vu's exclusive MultiView feature enables breaking the workspace up into multiple splits that
can be synchronized. Additionally, MultiView Extended allows a document tab to be
separated from the main workspace into a stand-alone, detached workspace.

@ Splitting the Workspace with MultiView

MultiView lets you break the workspace up into independent splits (up to sixteen of them).
Splits can be synchronized to pan and zoom in unison, and they can show different files or
different areas of the same file. Controls for splitting the screen are found on the Navigation
bar at the bottom of the workspace or in the Windows menu.

e To split the window horizontally, click ¥ or press CTRL+2.
e To split the workspace vertically, click B or press CTRL+H.
e To remove the current split, click I or press CTRL+SHIFT+2.

Click Sync on the Status bar to synchronize the pan and zoom settings. This is useful when
you need to compare multiple versions of the same document. Panning or zooming the
document in one window will automatically adjust the view in the second window.

Grid Snap Content| Markup Reuse Sync 36.00 x 24.00 in (22.79, 1.76)

@ Moving a Document From One Split to Another

To move a document from one split to another, click and drag its tab to the document tab
bar of the desired split. A small white arrow will appear on the destination tab as you
drag.

@ Working on Multiple Monitors with MultiView Extended

MultiView Extended lets you separate a document tab from the main workspace into a
stand-alone, detached workspace. This is especially useful for working with multiple
monitors.

e To detach a tab, click and drag the tab away from the document tab bar or right-click
on a tab and select Detach.

e To detach a document tab while leaving that document open in the main workspace,
hold down CTRL while dragging the document tab off the main window.

¢ To return the detached tab to the main workspace, click and drag the tab back to the
document tab bar.

Tabs cannot be moved to another instance of Vu.
Features of Detached Workspaces

e Can contain multiple document tabs, similar to the main Vu workspace.
¢ Can be split.

¢ Can Sync with the main Vu workspace.

s Always appears on top of the main Vu window.

25



Getting Around Vu’s Interface

Vu's interface is largely driven by a customizable Command Bar as well as customizable toolbars
and panel tabs.

%

Command Bar

Toolbars

STATE OF SOUTH DAKOTA
DEPARTMENT OF TRANSPORTATION
PLANS FOR PROPOSED
PROJECT P 0115(47)102

T T &l T - S.D. HIGHWAY 115
Left Panel e T ot o I MINNEHAHA COUNTY
#: f - Grading, Curb and Gutter, Storm Sewer, Structure

& PCC Surfacing
PCN 025C

Right Panel

Subject & Lock Checlnark ___ Author Date_ Color Comments

Bottom Panel

Sk X J orE >
F

dy ap 4 Content

At the top of the Vu window you will see the Command bar. The Command bar provides access to
tools and commands organized by group. It is customizable. Below the Command bar and to the
right edge are optional Toolbars. These toolbars provide customizable, one-click access to the tools
you need most.

PDFs appear in the Main Workspace. Multiple PDFs can be opened at the same time, each in its
own tab, allowing you to easily switch between them.

There are three Panels around the Main Workspace which contain a number of tabs. These tabs
provide quick access to tools for viewing, navigating, annotating, and gathering information from a
PDF. Vu provides Left, Right, and Bottom Panels and places commonly used tabs in them by
default, but you can freely move any tab to any panel, and it is even possible to detach a tab into a
floating panel for more flexibility. To detach a tab, click and drag it off the panel area. Once you
create a floating panel, any number of tabs may be added to the panel.

Below the Main Workspace but above the bottom panel, notice the Navigation bar, which contains
tools to help navigate documents. At the very bottom of the application window, below the bottom
panel, is the Status bar, which contains additional information and tools to help you interact with
PDFs smoothly.
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The Command Bar

The Command bar, located at the top of the Vu screen by default (see Getting Around the
Interface), is an easy way to find the most commonly needed tools. It's organized to keep tools
together based on the task at hand, so you can get your work done efficiently. The Command bar is
broken up into three parts: at the left is a global group of commands that are always present, in the
middle are commands that correspond to the menu selected at the top (File, Edit, and so on), and
to the right are menus for quick access to Vu's settings. Each is discussed below.

Like much of Vu's interface, the Command bar is customizable.

Customizing the Command Bar

There are several customizations that can be performed on the Command bar.

. To show or hide any of the Command bar groups, right-click anywhere on the
Command bar and check (to show) or uncheck (to hide) the name of the desired
group. (See below how to show the Markup Group and Measure Group in the
Command Bar)

. To show or hide the text labels below the icons on the Command bar, right-click anywhere
on the Command bar and select Show Text.

. To hide the icons on the Command bar when they are not in use, right-click anywhere on the
Command bar and select Minimize. The menu at the top of the Command bar will remain
visible and the icons will appear whenever one of the menu options is selected.

Additionally, many of the tools and commands found on the Command bar can be pinned to
toolbars (either one of the default toolbars or a customized one of your own creation; see Tools and
Toolbars: Customizing Toolbars for more information about adding and customizing toolbars).

. To pin a tool or command from the Command bar to a toolbar, right-click it and go to Pin,
then select the desired toolbar from the list that appears.

. Some icons on the Command bar are not commands themselves, but when clicked
reveal a menu of similar commands. These cannot be pinned to a toolbar, but the in
dividual commands in their menus can be: simply click to reveal the menu then click
Pin and select the desired toolbar from the list that appears.

Vo File  Edit . - B o Vo File  Edit

WebTab
-

Open iy -mail udio = —

v wa W : , w._ M
‘EA - ™ ~ —— n Getting Started = v z

. File = File

. : 5 -
Edit X W Edit
M View A view
L\ s wl-
Markup . . Markup
. A File Edit View Markup Measure Window Help 2
Measure Measure
; - L S r % i 5
v . - - - - = T =
. Window v W e [—] = h ~2 4 ﬂ Window
H Help Open Save Print E-mail Studio Signatures Forms WebTab H Help
S IV AR - ) Minno25cC Getting Started
BB
- Recenis
Getting Started.___
[~ | g

Minimize
E2
. Show Text

Minimize
ﬁ Show Text




Global Commands in the Command Bar

Some commonly used commands are included in the Command bar regardless of the current active
group.

Studio

ﬂ Tab Access Menu

The Tab Access menu turns on available tabs. Tabs that are highlighted (with a blue box around
their icon) are shown while those that are not are hidden. Selecting a hidden tab will cause it to be
shown. Selecting a shown tab will cause it to be brought to the front in whichever panel it currently
resides. To activate the Tab Access menu, click the orange triangle at the far left of the Command
bar.

‘ Open

Open (CTRL+0O): Invokes the Open dialog box, from which you can open one or more PDFs in Vu.

E Save and Save Menu

Save (CTRL+S): Click the main button to save the current PDF with any edits made during the ses-
sion. Click the arrow to the right to invoke the Save menu.

N

b=l Print
Print (CTRL+P): Opens the Print dialog box.

' E-mail and E-mail Menu

E-mail (CTRL+E): Opens a new e-mail message with the current PDF attached in your default e-
mail program. The PDF must be saved before sending. Click the arrow to open the E-mail menu.

. Studio

Studio: Opens the Studio tab for online collaboration.
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Command Bar Groups

File Group

©« wWww

Signatures Forms WebTab

B @ Sighatures Menu
This menu provides tools for managing digital signatures and digital ID certificates.
& Validate Signatures

Digital IDs...

Trusted Identities...

Validate Signatures: Attempts to validate all signatures in the document.
Digital IDs: Opens the tool used to create and manage digital 1Ds.

Trusted Identities: Opens the tool used for importing, exporting and managing identity certificates.
3] Forms Menu
This menu contains tools for exporting and resetting form data as well as highlighting form fields in a PDF.

Export Data

Highlight Ctrl+F7

Reset

Export Data: Exports the form data to an FDF, CSV or XML file.
Highlight (CTRL+F7): Toggles highlighting of form fields.
Reset: Clears all data from form fields.

= @ WebTab
WebTab: Opens a new WebTab.
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Edit Group

The Edit group provides commands and menus pertaining to object and text manipulation. It is ac-
cessed by clicking Edit on the Menu bar.

& ¥ ¥ K 7w e

History Clipboard Select Snapshot Search Spelling

@ 2‘) History Menu
The History menu contains commands to undo and redo previous commands.

¥ Undo Ctil+Z

(® Redo Cirl+Y

" Undo (CTRL+Z): Reverts to the previous document state. A history is maintained of operations so repeated
undos sequentially undo each previous operation.

Redo (CTRL+Y): Performs the last operation that was undone. If multiple undos were performed, then Redo will
sequentially re-apply the operations that were undone.

b
f“_-:_' x
B % Clipboard Menu

The Clipboard menu contains familiar commands to work with the system clipboard. These commands are only
available for Studio Session PDFs.

of Cut Ctrl+X
Ii Co py Ctrl+C

p Paste Cirl+V

Pastein Place  Cirl+Shift+Y

Delete Del

" Cut (CTRL+X): Cuts the selected markup and places it on the clipboard.

D Copy (CTRL+C): Copies information from a markup or the content onto the clipboard while leaving it in place.
I Paste (CTRL+V): Pastes a markup from the clipboard onto the PDF.

i) Paste in Place (CTRL+SHIFT+V): Pastes content in the exact position that it was cut or copied from.

X Delete (DEL): Deletes the selected markup.

&

@ ¥ Format Painter

Format Painter (CTRL+SHIFT+C): Copies appearance formatting and properties from one markup to another
markup or group of markups.
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Edit Group Continued

G SN Select Menu

Select Text

Select All Tet  Ctrl+ Shift+4

¥ Pan Shift+V

ko Select v
Select All Crl+A

Lasso Shift+0

IA Select Text (SHIFT+T): Click and drag to select text within a region.

Select All Text (CTRL+SHIFT+A): Selects all text in the currently active PDF page.
¥ Pan (SHIFT+V): Click and drag to pan the image.

R Select (V): Use to select one or more markups.

Select All (CTRL+A): Selects all markups in the currently active PDF.

& Lasso (SHIFT+0): Draw a free-form shape to select one or more markups.

m% Snapshot
Snapshot (G): Copies content and markups from the PDF to the clipboard, from which it can be pasted into a
Snapshot markup or another program.

Etm Search and Search Menu

Search (CTRL+F): Click the main button to open the Search tab, which enables searching for text within the PDF and
any markup in the PDF. Click the arrow to its right to invoke the Search Menu.

®®  DNext Result F3

88 Previous Result  Shift+F3

P Next Result (F3): Steps sequentially to the next search result.

% Previous Result (SHIFT+F3): Steps sequentially to the previous search result.

Abp :
g ¥ Spelling Menu

ABL

Check Spelling in Markups and Form Fields (F8): Runs the spell checker, which will underline any misspelled
words within the document.

Look Up: Looks up a selected word on the Wikipedia® website.
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View Group

The View group contains menus and commands to change the look of the workspace and open
documents. It is accessed by clicking View on the Menu bar.

Q 5 w

Tabs Toolbars Profiles Rotate View Navigate Rulers Interface

= L& Tabs Menu

The Tabs menu turns on available tabs. Tabs that are highlighted (with a blue box around their icon)
are shown while those that are not are hidden. Selecting a hidden tab will cause it to be shown. Selecting
a shown tab will cause it to be brought to the front in whichever panel it currently resides.

& b Toolbars Menu
The Toolbars menu toggles on and off various toolbars. A checkmark next to a Toolbar means it is on.
Select a toolbar to turn it on or off.

= &b Profiles and Profiles Menu

The Profiles menu shows a list of available Profiles. The current Profile is checked. Select a Profile to use
it; Vu's interface will automatically update to the new Profile's configuration. Click the Profile button to
bring up the Manage Profiles dialog box.

= @5 Rotate View Menu

E  Clockwise Ctrl+ Shift+ Plus

8  Counterclockwise  Ctrl+Shift+ Minus

The Rotate View menu lets the user rotate the view of the current PDF in 90° increments clockwise or
counterclockwise.

a® Navigate Menu
The Navigation menu contains the same tools as the middle and right sections of the Navigation bar.
¥ Pan (SHIFT+V): Click and drag to pan the image.

s« Zoom (Z): Click to zoom in; hold CTRL and click to zoom out. Click and drag a rectangle to make that
area fill the screen.

I4 First Page (HOME): Click to jump to the first page of the PDF.

4 Previous Page (CTRL+LEFT ARROW): Click to go to the prior page of the document.

» Next Page (CTRL+RIGHT ARROW): Click to go to the next page of the current document.

P Last Page (END): Click to jump to the last page of the document.

Go To Page: Click to specify a page in the document to which to jump directly.

© Previous View (ALT+LEFT ARROW): Click to go back to the previous view in the main workspace.
© Next View (ALT+RIGHT ARROW): Click to go to the next view in the main workspace.
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View Group Continued

| EW Rulers

The Rulers menu toggles the rulers on and off. The rulers appears along the top and left edges of the
workspace. Right-click on either ruler to choose to measure in Inches, Centimeters, Millimeters, Points,
or Picas.

The rulers have several useful features:

o Shows the bounds of the active page.
¢ Highlights the space occupied by a selected element of the page.
o Grouped annotations show as one highlight.
o Only the textbox area of callouts are highlighted.
o Flattened elements are not highlighted, nor are Notes or Attachments.
o Shows the current position of the mouse pointer.
e Scales according to zoom.
o Shows the position to be snapped to when snapping is enabled.

& 1l Interface Menu
This menu controls the visibility of main interface elements.
Command Bar (F9): Hides the Command bar.
Status Bar (F8):Hides the Status bar.
Navigation Bar (F4): Hides the Navigation bar.
Auto-Hide Tabs: Automatically hides and un-hides document tabs.

Hide Panels (SHIFT+F4): Hides any panels currently being shown or, if panels were previously hidden
using this command, causes them to appear. Panels hidden manually are immune to this command.
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Markup Group

The Markup group contain menus and commands for annotating PDFs. You can only affect your
own markups in Studio Session PDFs. It is accessed by clicking Markup on the Menu bar.

R KW

Lines Shapes Sketch Image Attachment Review Stamp

] A Text Menu

The Text menu contains tools to create text-bearing markups.

Typewriter W

Mote N

A Text Box (T): Places a text box markup.

3 Callout (Q): Adds a text callout markup.

[ Typewriter (W): Enables freely typing text on a PDF.
&l Note (N): Inserts a sticky note.

= / Pen Menu

The Pen menu contains markup tools that behave in a similar manner to a real-world pen.

Pen P

J# Highlight  H

Eraser Shift+E

/ Pen (P) Adds a free—drawn markup.
Highlight (H): Adds a semi-transparent line simulating a highlighter.
“ Eraser (SHIFT+E): Removes pen and highlighter markups.

= / Lines Menu

The Lines menu contains tools to create linear markups.

Line L
Arrow A

Arc Shift+C

Polyline Shift+N

Dimension  Shift+L

/" Line (L): Adds a line markup.

/" Arrow (A): Adds an arrow marku p.

¢~ Arc (SHIFT+C): Adds a curve markup.

V) Polyline (SHIFT+N): Adds a polyline markup.

¢ Dimension (SHIFT+L): Adds a dimension or leader line markup.
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Markup Group Continued

) B Shapes Menu
The Shapes menu contains tools to create outlined shape markups.

Rectangle R
Ellipse E

Polygon  Shift+P

Cloud i

Cloud+ K

! Rectangle (R): Adds a rectangular markup.

O Ellipse (E): Adds an elliptical markup.

L% polygon (SHIFT+P): Adds a polygon markup with no set angles.
(> Cloud (C): Adds a polygon with a cloud-like appearance preset.

& Cloud+ (K): Adds a polygon markup with a cloud-like appearance and callout box preset.

B~ Sketch Menu

The Sketch menu contains tools to create sketch-to-scale markups. The Sketch Tools make it
easy to create markups to an exact scale quickly. In addition to allowing for the creation of
precise markups, when used in conjunction with Tool Set Scaling it can be used to create very
useful tools for your Tool Chest.

Polygon Sketch to Scale

Rectangle Sketch to Scale

Ellipse Sketch to Scale

Polyline Sketch to Scale

“Polygon Sketch to Scale: Adds a polygon markup to an exact scale.
Rectangle Sketch to Scale: Adds a rectangle markup to an exact scale.
Ellipse Sketch to Scale: Adds an ellipse markup to an exact scale.

*Polyline Sketch to Scale: Adds a polyline markup to an exact scale.

BE Image and Image Menu

Image (I): Inserts an image from a graphic file accessible on your workstation. Click to the right
to access the Image menu.

i

ﬁ Crop Image

@ Crop Image: Crops an image markup.

= e Camera

@ camera (CTRL+ALT=+I): Adds an Image markup or embeds an image in a markup using the
camera in the laptop or tablet.
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Markup Group Continued
a@ Attachment
7 Attachment (F): Embeds a file in the PDF.

(E] :
B % Review Menu

This menu provides tools to markup text, such as in a review process.

- Review Text Shift+ Alt+R

Underline U
Squiggly Shift+U
Strikethrough D

Markup Spelling Mistakes...

¥. Review Text (SHIFT+ALT+R): Allows for marking text for edits without changing the text in
the PDF.

T Underline (U): Underlines the selected text.

T Squiggly (SHIFT+U): Creates a squiggly line under the selected text.

+ Strikethrough (D): Strikes out the selected text without removing it.

T Markup Spelling Mistakes: |dentifies spelling mistakes in the PDF content.
= & Stamp Menu

& Stamp: Contains available stamps. See the Stamp Tool section for more information.
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Measure Group

The Measure group contains the measurement and calibrate tools. You can only affect your own
markups in Studio Session PDFs. It is accessed by clicking Measure on the Menu bar.

Measure Tool Calibrate Linear Area Volume Cutout Count Geometric

Eté> Measure Tool
Measure (M): Launches the Measure tool and opens the Measure tab.
& "f Calibrate
Calibrate: Calibrates the document's scale to allow accurate measurements to be taken.

< :
= \/ Linear Menu

The Linear menu contains linear measurement modes.

Length Shift+Alt+L

B Perimeter  Shift+Alt+P

5 Length (SHIFT+ALT+L): Calculates a singular linear measurement.

= @ Area

Area (SHIFT+ALT+A): Calculates the area of a simple rectangle or of an irregular, polygonal
shape.

] @ Volume
Volume (SHIFT+ALT+V): Calculates the volume of an area with a defined depth.

= Cutout

Cutout: Allows you to cut out or subtract an area from an existing Area or Volume
measurement.

Elhm Count

Count (SHIFT+ALT+C): Places a markup for each mouse click, associating a running total of

counts with each markup as it is placed.

@ £2) Geometric Menu

The geometric menu contains measurement modes that calculate angles and circular
features.

a Diarmeter Shift+Alt+D

Angle Shift+Alt+G
A CenterRadius  Shift+Al+U

A 3-Point Radius  Shift+Alt+U

#®) Diameter (SHIFT+ALT+D): Calculates the diameter of a circular shape.
£ Angle (SHIFT+ALT+G): Measures a given angle as defined by three points.

/4 Radius (SHIFT+ALT+U): Measures the radius a circle, defined either center—out or by
indicating any three points along its circumference.



Window Group

The Window group includes commands for controlling the main workspace window. It is accessed
by clicking Window on the Menu bar.

I

Split Vertical Split Horizontal Switch : Close All Ahways On Top

B El Split Vertical
Engages MultiView™ and divides the workspace into two vertically oriented splits.
= m Split Horizontal
Engages Multiview™ and divides the workspace into two horizontally oriented splits.

Eliz' Unsplit

Eliminates the current split.

[} |
) Toggle

Toggles between vertical and horizontal orientation for the current split.

= ﬁ Switch

Puts the active document tab in the last active split and removes it from the current split.

3] [EI Balance

Sets all splits to equal size.

= EE Close All

Closes all open documents.

B i Always on Top

Keeps the Vu application over other applications which are open at the same time. Useful for

keeping a marked up PDF easily accessible while incorporating changes and comments back
into the CAD design.
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Help Group

The Help group contains commands and menus that link to help and other resources. It is ac-
cessed by clicking Help on the Menu bar.

- 28 &5 U ¥ 0

Help Resources Product Updates Contact Administrator About

] @ Help Menu

Help (F1): Opens the help file. Click the arrow to the right of the button to activate the Help
Menu.

Getting Started  F12

Keyboard Shortcuts

Getting Started (F12): Opens the Getting Started PDF.
Keyboard Shortcuts: Opens the Keyboard Shortcuts PDF.

&l & Resources

Resources: Opens a WebTab and connects to the Bluebeam website containing additional
training content for Vu.

&
= & Product Updates
Product Updates: Opens a WebTab with the Bluebeam website containing up-to-date
information about new versions of the Bluebeam products.
ﬁ'ﬁ".{]

= w Contact Menu

The Contact menu contains links to send e-mail with the computer's configured e-mail
client.

Technical Support

Make a Suggestion

Technical Support: Opens an email message to Bluebeam for a request for technical
support.

Make a Suggestion: Opens an email message for you to send Bluebeam your feedback on
the Vu product.

& Ia Administrator

Administrator: Launches the Bluebeam Administrator application. Most of the functionality
in the Administrator applies to the Bluebeam CAD and Office plugins, and the Bluebeam PDF
Printer. There is also a tab for Vu where you can set Vu to be the default PDF viewer if you
unchecked this option during the installation. Refer to the Administrator help for more details
on the Bluebeam Administrator. To find that help, once in the Administrator, go to Help >
Administrator Help.

& @ About

About: Opens the About dialog box, which contains licensing and software version
information.
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Managing Studio Account

Below are a collection of procedures detailing how to accomplish some common
goals in Studio.

& Change the Password on Your Studio Account

You must be logged into the Studio account for which you wish to change the
password.

P

Go to View > ®:Tahs > 7 Studio or press ALT+C to access the Studio tab.
Click == Home.

Click %* Settings on the Studio tab. The Preferences dialog box opens to
the Studio preferences.

Click Manage Servers. The Server Profiles dialog box appears.

Select the Studio server for which you wish to change the password and click
. The Edit Server dialog box appears.

Note: You must be currently logged into the account to change the
password.

Click Change Password. The Change Password dialog box appears.
Enter your Current Password and the New Password.
Reenter the new password in the Verify Password field and click OK.

= Recover a Lost Password

Go to View > ®:Tabhs > 7 Studio or press ALT+C to access the Studio tab.
Click ™= Home.

Click “* Settings on the Studio tab. The Preferences dialog box opens to
the Studio preferences.

Click Lost Password. An email message will be sent to the Login E-mail
address with recovery instructions.

& Change My Display Name in Studio

To change the name that Studio uses as your display name (not the username used
to log in), first log into the Studio account then see Editing Existing Accounts.
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Managing Studio Account Continued

® Editing Existing Accounts

You can only have one account on a given Studio server at a time, but the details for
an account can be changed as needed. Some fields (Name and Password) can only
be changed while you are logged into the account, while others (Server and
Domain/E-mail ) cannot be changed for the primary/default Studio server account
(switch to a different server before editing those fields).

To manage an existing account:

1. Goto View > ®E:Tabs > 7 Studio or press ALT+C to access the Studio tab.

2. Click % Settings on the Studio tab. The Preferences dialog box opens to the
Studio preferences.

3. Click Manage Servers. The Server Profiles dialog box appears.

e 3 Ty
Server Profiles &J
Servers
Server Email Password
E] studio bluebeam com user@domain.com sesesens
(=)
Close

. >

4. Select the desired account and click®™*. The Edit Server dialog box appears.

Edit Server |

Server: studio bluebeam.com

Domain / E-mail:  user@domain.com

Password:
[¥] Remember Password
=

] Use Windows Authertication

Name: Username

5 )

5. Edit any of the information shown as needed. Be aware of the following:

o You must be logged into the account to edit the Name and
Password fields. In order to change your password, click Change
Password. You cannot edit the Password field directly.

o The Server and Domain/E-mail fields for the primary/default
Studio server cannot be changed. To edit these fields, switch to a
different server first.

6. Click OK.
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Managing Studio Account Continued

= Manage Studio Notifications

Studio can be configured to send you notifications for any or all of the Sessions
and/or Projects you have joined. These notifications can be daily summaries or they
can come as certain events take place within the Session/Project or a combination of
both. Notifications are managed for each Project and Session separately.

1. Go to View > BE=Tabs > 7 Studio or press ALT+C to access the Studio tab.
You do not need to be logged into the Session or Project, but you do need to
be online.

2. Click =mHome.

3. Right-click the desired Session or Project and select Manage Notifications. A
new WebTab to the Studio Enterprise portal will open in Vu. Log in, if
necessary.

4. The Studio Enterprise portal page will show your current Studio
MNotifications Preferences. Select any of these options:

Project and Session-Specific Preferences

o Enable notifications for this Project/Session turns on
notifications for the Project or Session. Which notifications you will
receive is determined by what is selected under Account
Preferences as detailed below. If this option is not selected, you will
not receive any notifications for the Project or Session, regardless of
what is selected in Account Preferences.

Account Preferences

Select any or all of the available notifications that you would like to receive
for the Project or Session. Each notification is sent independently.

o Send me a daily digest of all Studio activity will send one email
at the end of the day, in digest format, summarizing all Studio
activity for the day.

o Send me an email about markup alerts will send an email
whenever a markup alert is directed at you (see Note below).

o Send me an email about updates to Sessions will send an email
whenever an update is made to a Session you have joined (see Note
below).

o Send me an email about updates to Projects will send an email
whenever an update is made to a Project you have joined (see Note
below).

Note: For the "event-based” notifications (that is, all but the daily
digest), Studio will check for applicable events every 10 minutes
and, if any are found, will collect them all in a single email. So, if
20 updates take place in a Session within 10 minutes, and you
are set up to get notifications for that Session, one email with
information about each of those updates will be sent to you rather
than 20 separate emails.

5. Click Apply.

Note: Do not uncheck “Send me an email about markup alerts” - this is how you are noti-
fied if your comments are rejected.
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Managing Studio Account Continued

& Alert Other Session Attendees to a Markup

When you send an alert to a Session Attendee concerning a markup, they will receive
an email with a snapshot view of the selected markup and available, associated
metadata. The snapshot is also a link into the Session and clicking it will not only
take the recipient directly into the Session, but straight to the markup as well. You
can send markup alerts for any markup, not just the ones you create yourself.

1. Join the Session and locate the desired markup.

2. Right-click the desired markup and go to Alert Attendee and select one of
the following:

o If this is the first time you have sent an alert in this Session, the only
option available is Choose. Select Choose and skip to the next step.

o If you have previously sent an alert in this Session, you can choose to
send this alert to the same Attendee or Group by simply selecting
them from the list. The alert is sent and no further action is required.

o If you have previously sent an alert in this Session, but you would like
to send this alert to a different Attendee or Group, select Other and
skip to the next step.

3. On the Alert Attendee or Group dialog box, select the desired Attendee or
Group and click OK.

o Only Session hosts can send alerts to Groups.

o When selecting a Group, an alert will be sent to all members of the
Group automatically.

o Hold down CTRL or SHIFT to select multiple recipients.
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Tabs

The three attached panels and any floating panels you have
created can hold a number of powerful, specialized tabs, which
provide efficient access to a variety of Vu features. This section
covers the most used tabs and the functionality each enables.

Click on View > I

Properties Tab

The Properties tab displays any attached files and metadata
about the currently active PDF. If a markup or group is
selected, the Properties tab will display the specific appearance
of the selected markup or group. By default, the Properties tab
appears in the right panel.

To display the Properties tab, click w . 4¥ properties or

press Alt+P.

, 18

B

Bookmarks
File Aiccess

Forms

JavaScript Console

Layers

Links
Markups
Measurements
Properties
Search

Sets
Signatures
Spaces
Studio
Thurmbnails
Tool Chest

3D Model Tree

Alt+E
Alt+A
Alt+0)

Alt+]
Al+Y
Alt+N
Alt+L
Alt+U
AlE+P
Alt+1
Alt+2
Alt+d
Alt+5
Alt+C
A+ T
Alt+X

Alt+3
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Search Tab

The Search tab allows you to search for text in the current PDF, all open PDFs, PDFs in a folder, or

in the files in the Recents list. You can perform a Text search or a Visual search. You can also
Search and Replace.

. To display the Search tab, click f . @ Search or press Alt+1 or Ctrl+F.

Text Search Visual Search

@ Ted  Q Search ) Text

) Visual ’ Get Rectangle ] @ Visual [ Get Rectangle l ®

Search In: Search In: [ Refine Colors l

’Hecerﬂs 'r] [Current Document 'r]
C:\Users"AdminDocuments C:M\Projects"\PDOFs

~_Options

Search Pages Low High
[7] Search Filenames Sensitivity: E[

] Search File Propetties Search Muttiple Rotations

Search Fomm Fields Fitter by Color

"] Search Markups Limit by Selection

Search Markups

Case Sensitive
O [ Search for Fine Detail

[7] Whole Words Only

Text Search

Text must be present in the PDF file for text search to find it. Scanned PDF files are images and do

not contain any text, so they are not searchable. See Optical Character Recognition (OCR) in the
Bluebeam Revu Manual for details on how to make scanned documents searchable.

VisualSearch

VisualSearch allows for the searching of graphical symbols in PDFs. To set the search criteria,
define a rectangle around the symbol or graphic that you want to search for in the document.
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The Tool Chest

The Tool Chest is a powerful feature that makes the marking up of documents much more efficient.
Once a markup is created, it can be easily recalled using the Tool Chest. The Tool Chest will store
your most used markups in a central, easily accessible location.

By default the Tool Chest is in the left panel. To access the Tool Chest, click I > Tool
Chest or by press Alt+X.

Using Tool Sets
Click any tool in the Tool Chest to select it, then click on the document to place the markup.
To copy a tool from one tool set to another tool set:

* Click and drag the icon to the desired tool set.

To reorder the tools within a set:
» Click and drag the icon to the desired location.
To delete a saved tool:
+ Click a tool to select it, then click the E Delete Icon on the Tool Chest button bar.
-or-
 Click a tool icon to select it, then press the Delete key.
-or-

+ Right-click a tool icon, then click Delete.

To duplicate a tool:

* Right-click a tool icon, then click Duplicate.

To change the colors of a tool:

*Right-click a tool icon, then click Change Colors.

Reusing Recent Tools

The Recent Tools section records every markup as it is added
to the PDF.

A

b

To reuse a tool, simply click the icon and then click on the PDF
to place the markup.

The Recent Tools history is temporary; it only lasts until Bluebeam Vu is closed.
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Permanently Saving a Tool to be Reused

To save a recently used tool so it will remain after the program has been closed, click and drag the
tool's icon from Recent Tools into My Tools or another tool set, or right-click the icon and then click
Add Item to My Tools.

To save a markup on the document as a reusable tool, right-click the markup, hover over Add to
Tool Chest, then click the tool set to save it to (For example, My Tools).

Managing Recent Tools

If too many tools have been used recently to view them all in the Recent Tools section, an arrow
appears to the right of the row. Click the arrow to access all recent tools.

5 %
Sequences & Actions ‘/--w /‘

Curves

Shapes / TEST

+ Recent Tools

Symbols

To set how many recent tools to retain:
, P , : .
* Click the . gear at the top right of the section, then hover over Maximum Recents.

* In the Maximum Recents submenu, click a value to set the number of recents.

Clearing Recents and Hiding the Recent Tools Section
To clear all recent tools without closing Revu:

* Click the gear at the top right of the section.

» Click ﬂCIear Recents.

To Hide the Recent Tools Section:

wll
+ Click the gear at the top right of the section, then click Hide.

:_l
Click the . Manage Tool Sets menu in the Tool Chest button bar, then click Recent Tools, to
show it again.
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Properties Mode vs. Drawing Mode

Items in My Tools, Recent Tools and custom tool sets can function in two different modes. The
tool icon changes to show which mode is currently being used.

TEST A
« Double-click — E]
Drawing Mode Properties Mode

Properties mode adds a new markup with the same display properties of the saved markup. In
this mode the Properties (as displayed in the Properties tab) are retained but the exact
dimensions, text, and so on are not. In the preceding example, using the tool in Properties mode
would create a new yellow text box with black border and text color, but no text would be inside
the box yet, nor would the box have a fixed size.

Drawing mode adds a new markup that is an exact duplicate of the saved markup, as if you'd
copied and pasted the original markup rather than made a new one of a similar type.

To change the mode, double-click on the icon. All information of the original markup is always
retained when switching modes. Only the icon and the way that the markup is added to the file
changes when the mode is switched. By default, most tools are saved in Properties mode. There

are some markups that always remain in Drawing mode. A Stamp and a Grouped markup are two

examples.

To set all markups to default to Drawing mode:

+ Click the gear at the top right of the section, then uncheck Properties Mode.

Sequences & Actions

A Sequence allows a text based markup to increment in value each time that a markup is added
to the PDF. The updating sequence value can be a number or text. An Action allows you to add
hyperlinks to tools in the Tool Chest.

Pinning a Tool Set

» For quick and easy access, a Tool Set can be pinned to any Toolbar.
* Click the small gear to the right of the Tool Set name.

» Click ﬂ Pin to Toolbar, then select the specific Toolbar.
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Working with Stamps in the Tool Chest

Standardized stamps can be delivered via section specific Tool Sets in the Tool Chest. Here are
some examples:

A 4 ==

| &

- My Tools

=

Actions

OOOQ@)@@@
g

Placing Stamps from the Tool Chest
To place a stamp:
+ Click the thumbnail of the stamp you would like to place from the desired Tool Set.

* Click the PDF in the location you would like the stamp to appear.

Unlike placing a stamp off of the Stamp Menu, placing a stamp from a Tool Set produces a
dynamic preview of the stamp on your cursor. This feature results in much easier stamp placement.

Applying a Stamp from the Tool Chest to *
Multiple Pages

Ctrl+ X

There are a few options for applying a stamp to
multiple pages, the Apply to ... Pages context
menu options, and the Apply Stamp tool. ‘ : Ctrl+V

Format Pair *er ift+C

Ctrl+C

Apply a Stamp from the Tool Chest to All
Pages

 eck
This will copy and paste in place any markup on all
Add to Tool Chest
the pages of a PDF.

Set as Default

* Right-click a markup, then click Apply to

Apply to All Pages

All Pages. Properties
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Markups List

The Markups list automatically tracks markups placed on a PDF, including
author, date, color, and comments associated with each markup. By default
it is found in the bottom panel.Go to View > =Tab5 > # Markups or
press ALT+L to show the Markups list if it is hidden.

= Markups List Toolbar

The Markups list toolbar contains tools for organizing, processing,
iImporting, and exporting data.

— ) ;
| fiil Columns ~ i - -

+ Expand All and — Collapse All: Expands or collapses the entire list.
“ Previous and ¥ Next: Moves to the previous or next markup in the list.

7 Filter and ™ Clear Filters: Toggles column filters on and off and clears
previously applied filters.

& Hide Markups: Hides all markups in the current PDF file. Markups will
not be shown or printed when this mode is enabled. This mode is
temporary and will be reset the next time Vu is started.

a Search: Filters the Markups list based on the text entered in the field.
ffl Columns: Selects which columns are shown in the Markups list.

X Delete: Deletes a selected reply from the Markups list or a selected
markup from both the PDF and the list.

Reply: Replies to the selected markup. Replies appear on a new indented
row below the markup in question.

@ status: Sets the status of the markups. The default statuses are
Accepted, Rejected, Completed, Cancelled and None.

Checkmark: Checks or unchecks the checkbox associated with the
selected markup. Also provides a command to clear all checkboxes.
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Markups List Continued
= Markups List

The Markups list is formatted as a table with each row representing a
markup that has been added to the active PDF and each columns showing a
particular piece of information about the markup.

As a row Is selected, the view of the PDF in the workspace will jump to the
location of the associated markup. This makes it easy to use the Markups

list to step through the markups in PDF using either the # Previous and ¥
Next buttons or the UP ARROW and DOWN ARROW keys.

To sort by any column, click the desired column header. Click again to
reverse the sort order. When markups are sorted by column, they are

collected under section headings found in the Subject column. Each section

has a toggle triangle; click it to expand or collapse the section.

The following examples show an expanded, collapsed, and partially
collapsed list sorted by Page number:

Expanded List

Hatus Checkmark  Author

Partially Collapsed List
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Columns Menu

The Columns menu allows you to toggle on and off various columns. A column that is turned on
will appear in the top row of the Markups list and will display a check box next to the name in the

menu. Click a column name to turn it on or off. To sort by any column, click the column's name on

the header. Click again to reverse the sort order.

Subject: Displays an icon of the markup and text referring to the subject
of the markup. By default, the text contains the name of the tool used to
create the markup (Pen, Highlight, Callout, etc.). This text can be
changed in the Subject field in the Properties tab, or by double-clicking
on the Subject text in the Markups list.

Page: Displays the name of the page on the PDF on which the markup

is located.

Page Index: Displays a numeric value indicating the page on which the
markup or measurement resides. The Page Index is a useful column for
sorting when exporting to spreadsheet programs.

Lock: Toggles whether the markup is locked for editing or not. If locked,

Status: Can be set to one of the default states or a custom status. The
default values are Accepted, Rejected, Canceled, Completed and
None. Once the status is set on a markup, you can sort by status.

Checkmark: Toggles the checkbox, enabling the Markups list to be
used as a basic checklist. As changes are being reviewed, click to check
the box; click again to uncheck it.

Author: Indicates the username of who made the markup. Double-click
this field to edit your displayed name. To set the name globally, click
Settings > Preferences > General, then enter a name in the User box.

Date: Displays the date and time the markup was modified based on the

system time.

Creation Date: Displays the date and time the markup was created based on the system time.

appears in the box, and the markup cannot be moved or
changed. If unlocked, the box is clear and the markup can be edited.

Subject
Page

Page Index
Leck
Status
Checkmark
Author
Date
Creation Date
Colar

X

v

Width

Height

Comments
Length

Area

Volume
Count
Measurement
Label
Sequence
Layer

Space

3D View
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Color: Displays the fill color that was used for the markup. You may sort by this column to group
all "red" or "blue" markups.

X and Y: Display the coordinates on the PDF page where the markup is located, counted from the
lower left.

Width and Height: Display the size of the markup itself.

Comments: Displays the comments from the General section of the Properties tab for this
markup. Double click in this field to change the comment associated with the markup.

Length, Area, Volume, Count, and Measurement: All display values associated with
Measurement markups.

Label: Displays the label associated with the markup. Label can be changed in the General
section of the Properties tab. For measurement markups, it is common to use the Label field to
specify the type of material that's being measured, such as "Asphalt Pavement 1" or "Conduit 3".

Sequence: Records the numerical value associated with a Sequence markup.
Layer: Displays the Layer the markup is associated with.
Space: Displays the Space that contains the markup.

3D View: Displays the 3D view that contains the markup. Click to jump to that view in the 3D
window.

Context Menu

Right-click on any field in the markup list to display a context menu for ™
performing functions on the currently selected cell. The first option,
Copy, stores the contents of the cell on the clipboard, enabling the
pasting of the information within Revu or other Windows applications. Layer

Copy 'Approved’

Lock Ctrl+5hift+L
Reply

Set Status

Check

Delete

Properties
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Working with Profiles

Profiles provide an easy way to store the toolbar, menus, and other display settings within Vu.
Profiles can also be used to shape the User Interface of Vu for particular job functions within your
organization. For example, you may create a simplified interface, turning off most of the toolbars
within Vu, for those users within your organization who would only be viewing PDFs and not have
need to edit PDFs. Additionally, you could turn on only the most basic markup functions without any
of the advanced editing functions and save a profile for basic markup users.

The toolbar settings are available from the Profile illl button menu. The check next to the
profile name indicates the currently active profile setting. To switch to a different profile, select
another profile from the menu. Once selected, the Vu interface will update based on the settings
defined in the new profile.

Preferences

The Preferences dialog enables customization of Bluebeam Vu settings. This section briefly
describes some commonly used settings, organized by the section of the preferences dialog that
contains it.

To invoke the Preferences dialog:
. On the Command Bar, click Settings, then click Preferences.
-0r-

. Press Ctrl+K.

Some commonly changed preferences will be discussed in this section.
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1 Preferences B
Camera # |  Documert
Document 1 c Mol _ =
s ave Mode: | Publish Without Revisions |
Faorma Page Layout: [Pu_rtn Detect by page size v]
General Single Display: [Frt Page v]
Grid & Snap e S
Uik L ontinuous Display: [Frt Width T]
Import/Export Maximum Zoom: 8400 : *
JavaScript [] Rotate all pages by default
Marku i
Markuss b E{. Auto-Feorder Bookmarks
Navigation [] Prompt user if file is locked
PDEAA, - [¥] Find Hyperinks in PDF Contert
Presentation [¥] Remember Last Page
Rendering
Rendering 3D
Sets
Sets (Advan. ..
Signature x
| impott | | Export | | ok || caneal |
General Preferences ﬁ
User: Each time a markup is Documert e
Filz Az
made, Vu records who made || = User: Admin
it. This field defines the General Enable Document Recovery
Gd & Snap Allow Multiple Instances
name to use.
Impart/Export
Markup Enable Auto-Complete
Enable Document Markups Tab | Show Splash Screen
Recovery: If Vu CIUitS Navigation 3 [7] Use Lange lcons
. . . FOF/A ]
unexpectedly with this option || .~ | Resst Hidden Messages |
set, the next time Vu is Eenjeﬁng 0 Tab Truncation: [Stat - |
. . endering
started, it will attempt to Sots Dk Light
recover unsaved changes to Signature Bichtness: [ ]
the document(s) open in the 2;::3:;”* n
previous session. Startup [[] Classic Mode [7] Classic Menu
Studio -
Allow Multiple Instances:

This enables or disables the
Multi-View feature.

Enable Auto-Complete: Remembers previously entered text. Click the Manage button to edit the

auto-complete history.




Show Splash Screen: Enables or disables the Vu splash screen when Vu is first launched.

Use Large Icons: The User Interface Icons will be displayed larger and support High Resolution

Displays.

Reset Hidden Messages: Resets the display of the dialog boxes where "Don't Show Again" was

selected.

Tab Truncation: Determines if the file name in the opened tab, truncates the beginning or end of

the name.

Brightness: Sets the overall brightness of the Vu interface.

Classic Mode: Switches to an emulation of the appearance of the default interface for VU prior to

version 6.

Classic Menu: Switches the menus to classic menus.

Grid & Snap

Units Section

Application Units: Defines
the system of measurement
to use for rulers and
measurement dimensions.

Grid Section

Show Grid: Provides control
over displaying the grid. Also

Preferences S
o =1
Camera | Units
Document I T
s s M Sets units for Rulers, Grid and Layout
Foms
General Giid
Grd & 5 A
H:'p p :ap [} Show Grd Grd Spacing: (02500 = Inches
erinks . =
Import/Expart |} Snap to Grid
JavaScript
Markwup snap
Markups Tab [ 5nap to Content
Mavigation =
POF/A [} Snap to Markup
Preserttation [¥] Snapto Lines +
Rendering [¥] Snapto Curves lE- i
Rendering 30 [ Snzpto Mid-Paints | . 5
Sets [#] Snap 1o End-Foints | =i
Sets (Advan... | [¥] Snap o Intersections ™ |
Sgnature T

IE] | Cancel

Snap to Grid: Makes any points used to define a markup line up with the defined grid. Also

controlled by the Snap button on the Status Bar.

Grid Spacing: Controls increments between grid units, which affects the snap-to resolution as
well as the spacing of the grid markers that are displayed on the PDF. A smaller increment makes
a smaller grid, a larger increment makes a larger grid.
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Snap

| il

Snap to Content: Snaps markups to the underlying PDF vector content. A small ‘[Ju
box appears over the underlying PDF content when markups are being made. The
following image demonstrates the behavior as a line markup is being drawn. Snap
to Content does not snap to text or images in the PDF, only vector images such as
lines and shapes. It is also controlled by the Content button on the Status Bar.

Snap to Markup: Snaps the cursor to other markups in the PDF. This can also be controlled by the
Markup button on the Status Bar.

With Snap to Markup enabled, two related behaviors will occur. The cursor will snap to points on
other markups, like Snap to Content snaps to points in the PDF content. Revu will also display —
and the cursor will snap to — guidelines that are based on lines in nearby markups.

Snap to a point Guidelines creating a Polygon Guideline creating aligned Rectangles

Snap Color: Determines the color of the indicator box.

Sensitivity: Move the slider to High to make the snap area smaller. Move the slider to Low to
make the snap area larger.
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Markup

Reuse Markup Tools: If checked, the last markups used will remain selected so it can be used
over and over again. If unchecked, after a markup is placed Vu will switch back to pan mode.

Dynamically Set as Default properties: Remembers the last property settings for a markup. For
example, if the appearance properties for a rectangle markup were set to a Green color, 2 point
wide line, the next time that the rectangle markup is selected, these properties will be used.

#

Autosize Text Box and Pt e 2
Callout Markups: Fits the

. r"'—'—|
surrounding text box to the Camera » | Marup
entered text for a callouts 23:::9 ] Reuse Markup Tools
and text marku ps. After Fun1.'|s [¥] Dynamically Set as Default Properties
editing the text in a Free General [7] Autosize Text Box and Callout Markups
Text or Callout markup, the Grid & Snap [¥] Scale Grouped Markups' Properties
text box will resize et | [7] Embed Forts

) ) Import/Export _
automatlcally to fit the text. JavaScript [ | Show Author and Date in Pop-Ups
Embed Fonts: Includes i W PanPoplls  Qpacky |70 :

) i Markups Tab 1 Cony sel i
[ py selected text into Text Markups

Iﬁztzgied for markups in E;"F‘%‘:““ j{HighIight. Undesine, Sauiggly, Strkethrough)

' Presferrt ~tion [#] Retain Layer Information when copying Markups
Show Author and Date in Rendering
Pop-Ups: Displays Author Rendering 3D ekt e Encodig
and Date in popup notes Sets :

. Sets (Advan... Drag Behaviorfor Shapes: | Drag Rectangle =
when an markup is double- Bk A
clicked. The title and author || ——— T
. [ Impart ] | Export | l 0K Cancel

will also appear when a note '

markup is added to a PDF.
Print Pop-Ups: Check to print Notes and Comments popup boxes.

Opacity: Opacity level that Notes and Comments popup boxes will be printed if Print Pop-Ups is
checked.

Copy Selected Text into Text Markups: Any time a text markup is used, the annotated text will
be copied to the copy buffer so that it can be pasted into other applications. Text markups are
Highlight, Underline, Squiggly line, and Strikethrough.

Retain Layer Info when copying Markup: Layer information will be copied when you copy a
markup. If you copy a markup to another PDF, its layer will be created in the new PDF.
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Use Relative Paths for Hyperlinks and Actions: Set the default status for paths to be "relative"

when Hyperlinks and Actions are created.

Set 'Open in New Window' option for Hyperlinks and Actions: Set the option to open a
Hyperlink or Action in a new window when the Hyperlink or Action is created. This option only
applies when viewing PDFs in Acrobat or Reader. Vu already opens the links in a new tab.

Default Image Encoding: Chooses the format in which embedded images and inserted image

markups are stored in the PDF.

Drag Behavior for Shapes: Determines whether, when drawing certain shapes (polygons, area
measurement), a rectangle is used or whether the drag behavior sets control points for the Bézier
curves used to define the shape. The effect will be either a rectangle is dragged, or a curve shape

will be drawn.

Navigation
Preferences
Mouse Wheel Section
Camera
Set how the mouse wheel Document
behaves in this section. g
Forms
Single Page Mode: Sets the Sel
mouse wheel behavior in single ﬁ:seiligzp
page mode. Choose either ppotiousd |1
Zoom or Scroll. JavaSeript
. Markup
Continuous Mode: Sets the Markups Tab
mouse wheel behavior in Navigation
continuous mode. Choose il
. .. Presertation
Zoom or Scroll. This behavior is Rendering
independent of the Single Mode || | Rendering 20
setting. Sefs
Sets {Advan...
Reverse Mouse Wheel when | Signature ¥
Zooming: Changes the Eort |

=
» | Mouse Wheel

Single Page Mode: | Zoom v
Continuous Mode:

[7] Reverse Mouse Wheel when Zooming
Senstivity: 14 =
[¥] Enable Horizontal Mouss Wheel

Cptions

[7] Synchronize Views

[¥] Enable Horizortal Scrollbar
[7] Show Vertical Scrollbar on Left
[7] Show Full-Sereen Crosshair
[¥] Lock Panningin Fit Width

Mode: |Document =

o)

direction for when the mouse

wheel will zoom in versus zoom out.

Sensitivity: Controls how much the zoom level changes per mouse wheel click.

Enable Horizontal Mouse Wheel: Enables panning for mice that have tilt-able scroll wheels.
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Options Section

Synchronize Views: Synchronizes the viewing windows when displaying the PDF in side-by-side
Split View mode. The Mode can be changed to sync by Document or by Page. For example, this
is useful when you need to compare two different versions of the same document. Moving the
document in one window will automatically adjust the view in the other window(s). This can be
quickly toggled on and off with the Sync button in the Navigation bar.

Enable Horizontal Scrollbar: Toggles on and off the horizontal scroll bar at the bottom of the
document tab.

Show Vertical Scrollbar on Left: Displays the vertical scrollbar on the left side of the PDF page
instead of the right.

Lock Panning in Fit Width: Constrains panning to vertical movement when in Fit Width mode.
This prevents the page from sliding sideways if the mouse is moved slightly horizontally.

Maximum Zoom: Sets the maximum percentage the workspace will allow zooming of PDFs.

Enable 3D Mouse: Enable 3D navigation with a 3D mouse.

Studio
Account Preferences P
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